
 

About This Guide 
 

Overview 
The PictureTel Live200 for Windows NT Product Guide describes Live200 windows, toolbars, and menus. It 
also defines the key terms you need to know to use Live200 and contains information about the Live200 
preferences and hardware and communications settings. Review this online product guide before accessing 
Live200 to familiarize yourself with the product before you use it.  

 Step-by-step instructions about using Live200 operations, commands, and menu options are in the online help. 
Access the online help while using Live200 to immediately obtain the instructions you need to complete tasks.  

Click the following links for more detailed information about:  

• Audience 
• Information Summary 
• Using Online Help 
• Reviewing the README File 

 

Audience 
The audience for this guide is the person who uses PictureTel Live200 for video, audio, and data conferencing 
calls. You should have a working knowledge of Microsoft® Windows®NT and how to use applications within 
the Windows NT environment.  

 

 



Information Summary 
The PictureTel Live200 for Windows NT Product Guide includes the following information:  

• Live200 Components  
• Terminology 
• Live200 Calls 
• Navigation within Live200 Main Window  
• Navigation within Live200 Video Windows 
• Live200 Address Book Lists 
• Live200 Preferences  
• Troubleshooting  
• Hardware and Communication Settings 

 

Using Online Help 
Live200 provides quick and easy access to information about operations, commands, and menu options. Step-
by-step procedures on how to use all features of the Live200 system are documented in the PictureTel Live200 
online Help, which is available by any of the following methods:  

• Click the Help button in a window or dialog box.  
• Click your right mouse button on an item to access What's This Help. This type of help provides a brief 

pop-up window for a specific control or option in a window or dialog box. 
• Choose Help Topics from the Help menu in the Main toolbar to access the Live200 Help Topics 

window. 

 

Reviewing the README File 
The README file is an HTML file that you can view online or print. The README file documents changes 
that occurred in Live200 since the printing of this guide.  

 
 
 



Introducing PictureTel Live200 for Windows NT 
 

Overview 
PictureTel Live200 for Windows NT is a personal videoconferencing system that you can use to conduct 
meetings and share data with users of any H.320-compliant videoconferencing system. Live200 for Windows 
NT offers full-color, full-motion, live video and audio communications, as well as interactive information 
sharing using Microsoft NetMeeting. When you are not in a videoconference, you can use the Live200 board to 
access the Internet and gain remote access to other systems at speeds of 64 kbps or 128 kbps.  

Click on the following topics for a description of  the PictureTel Live200 components and its compatibility with 
other desktop videoconferencing systems.  

• Software Component 
• Hardware Component 
• Video Camera 
• Audio Device 
• Optional Equipment 
• Compatibility 

 

Software Component 
PictureTel Live200 software runs under Microsoft Windows NT 4.0. It uses toolbars, pull-down menus, 
keyboard shortcuts, and other standard features of Windows NT software. For step-by-step instructions on 
installing the software, see the PictureTel Live200 for Windows NT Installation Guide.  

 

Hardware Component 
The Live200 board gives your computer the specialized processing power it needs to send and receive live 
video images and audio signals. The Live200 board also provides the interface your computer needs to connect 
to a standard ISDN BRI (Basic Rate Interface) digital communication network.  

For step-by-step instructions on installing hardware, see the PictureTel Live200 for Windows NT Installation 
Guide.  

   

 



Video Camera 
The Live200 video camera is a miniature color camera for the desktop environment. The camera mounts either 
on top of your computer monitor or on an overhead shelf, depending on your desktop requirements.  

The camera has an up and down tilting base that lets you adjust its position.  

 

Audio Device 
The Live200 system can be used with the single earpiece that has an attached microphone or with the external 
microphone with multimedia speakers. You can also use the speakers and a microphone from another 
manufacturer.  

 

Optional Equipment 
You can connect optional equipment, such as a PictureTel speakerphone, to the Live200 system. You can also 
use the optional dual-input video cable to connect another video source, such as a document camera.  

 

Compatibility 
Desktop Videoconferencing Systems  

PictureTel Live200 is compatible with the following desktop videoconferencing systems:  

• PictureTel Live50 TM 
• PictureTel Live100 TM 
• PictureTel Live200 TM for Windows 95 
• PictureTel LiveLAN TM 

Group Videoconferencing Systems  
Live200 is compatible with the following group videoconferencing systems:  

• PictureTel System 1000 TM 
• PictureTel System 4000 TM 
• Venue·2000 TM 
• Concorde 4500 TM 
• SwiftSite TM  
• Data conferencing compatibility with PictureTel GroupShare using T.120 functionality. 

Note: See the README file for the release version numbers of the PictureTel products. 

You can also make video, audio, and data calls to other videoconferencing systems from various manufacturers 
based on the H.320 international standard.  



Live200 Calls 
 

 

Overview 
You can use Live200 to connect with other users of any H.320-compliant videoconferencing system to 
communicate interactively in real-time. Using Live200, you can conduct meetings and share data with the other 
participants in the call. You connect with other users by dialing numbers to make calls, just like you do when 
using a telephone; only with Live200 you can make different types of calls: video, audio and data; video and 
audio; and audio only.  

Click the following links for more detailed information about:  

• Video Calls 
• Audio-Only Call 
• Answering a Call 
• Rejecting a Call 
• Adjusting your Ring Volume 
• Ending a Call 
• Call Log 

 

Video Calls 
Video calls enable each participant in the call to see each other in a window on their computer, to carry on an 
audible conversation, and to share onscreen data. With Live200, you can make point-to-point video calls.  

Point-to-point calls are between you and one other participant.  

 

Audio-Only Call 
An audio-only call does not send your video image to your calling partner but lets you talk back and forth. You 
make an audio-only call through the ISDN network transport.  

 



Answering a Call 
You can choose to manually or automatically answer a call.  

 To manually answer a call:  

1. Click Answer Call in the Incoming Call dialog box.  

To automatically answer a call:  

1. Choose Preferences in the Tools menu.  
2. Select Auto answer incoming calls in the Call tab of the Preferences window. 

Note: If your system is set to automatically answer incoming calls, anyone can place a call to your site 
and interrupt a meeting in progress or look at equipment and whiteboard notes left in an empty room.  

 If the person calling you is listed in your address book list, the name of that person is identified in the Incoming 
Call dialog box (this is called Caller ID).  

 

Rejecting a Call 
If you do not want to answer a call, click Reject Call in the Incoming Call dialog box. The caller receives a 
message that you are not available to answer the call and the dialog box on your screen automatically closes 
when the caller hangs up.  

 

Adjusting Your Ring Volume 
Your computer notifies you by ringing when you have an incoming call. You can increase or decrease the 
volume of your computer's ring or turn it off.  

If you set up your computer to manually answer a call, and you turn off the ringer, you are alerted that you have 
an incoming call by the Incoming Call dialog box. If you set up your computer to automatically answer a call 
and you turn off the ringer, you cannot be alerted that you have an incoming call.  

 Note: You can adjust the ringer volume for external speakers, such as the multi-media speakers or the 
earpiece, using the Call Preferences tab in the Preferences window, but not for speakers that are internal 
to the PC. 

 



Ending a Call 
Click the Hangup button in the Remote Video window or choose Hangup in the Main toolbar to end a call 
with your calling partner. You can also wait until your calling partner hangs up. Once your calling partner is 
disconnected, the call ends.  

 

Call Log 
The call log list automatically keeps track of every incoming and outgoing call that you make with PictureTel 
Live200. It does not log calls that fail to connect. The call log list displays information from the call log 
database about your incoming and outgoing calls.  

Use the call log list to retrieve ISDN numbers that you need and might have forgotten. You can also compare 
your phone bill against the call duration times that appear in the call log list.  

 

The Call Log list displays the following information:  

• Name of your calling partner  
• ISDN number you dialed  
• Type of call (incoming or outgoing)  
• Date and time of the call  
• Duration of the call in hours, minutes, and seconds  

The View menu in the Call Log dialog box provides the following choices:  



 

• Incoming Calls displays only calls that you have received.  
• Outgoing Calls displays only calls that you have made.  
• All Calls displays all calls that you received and made.  
• Close exits the Call Log dialog box. 
• Print opens the Print dialog box. 
• Print Preview opens the document in the Print Preview window. 
• Print Setup opens the Print Setup dialog box. 

  



Navigating Within the Main Window 
 

 
Overview 
You can navigate within the Live200 application by using the Main toolbar. The Main toolbar contains buttons 
and menu commands that you can use to immediately access all Live200 functions. 

Click the following links for additional information:  

•   Main Toolbar  
•   Main Toolbar Buttons  
•   Additional Main Toolbar Buttons  
•   Status Line  
•   Call Menu  
•   Hotlist Menu  
•   Tools Menu  
•   Window Menu  
•   Help Menu  

 

Main Toolbar 
Once you start PictureTel Live200, the Main toolbar appears.  

 

 

 

Main Toolbar Buttons 
The buttons on the Main toolbar are set with the default button settings. You can change and customize the 
Main toolbar buttons at any time. See Setting Preferences or the online help for instructions on customizing the 
Main toolbar  

   



 

The Make Call button lets you make audio, video 
and data calls over a phone line network 
connection.  

 
The Hang up button disconnects audio, video and 
data calls. 

 

The Address Book button opens the Address Book 
window, which provides flexible telephone 
directories for storing phone numbers and other 
information about other individuals. 

 

The Hotlist button provides a speed-dialing list for 
your most frequently called phone numbers. It also 
contains the most recently dialed numbers. 

 

The Local Video button opens the Local Video 
window, which displays the image that you are 
sending to your calling partner and brings it to the 
top. 

 

The Remote Video button opens the Remote Video 
window, which displays the image that your calling 
partner is sending you and brings it to the top. 

 

The Audio/Video Mute button turns off both the 
microphone and the camera so your calling partner 
cannot hear or see you. A red circle superimposed 
on the button means off. 

 
The Help button opens the Help Contents window, 
which provides help on Live200 features. 

 

 
Additional Main Toolbar Buttons 
You can add the following buttons to the Main toolbar using the Toolbar tab in the Preferences dialog box. See 
the online help or Setting Preferences  for more information.  

 

The Audio Off button lets you turn off your 
microphone so that your calling partner cannot hear 
you or local conversations. A red circle 
superimposed on the button means off. 



 

The Video Off button lets you turn off the video 
image so that your calling partner cannot see you. A 
red circle superimposed on the button means off. 

 

The Context-Sensitive Help button turns your 
pointer into a help icon that you can use to get help 
on Live200 functions.  

 

The Hardware Settings button opens the Hardware 
Settings window, which lets you change your audio, 
video, audio compression, video compression, 
network, and data rate settings. You can also view 
information about the Live200 board, such as 
revision levels.  

 

The Call Log button opens the Call Log window, 
which provides historical information about 
incoming and outgoing calls.  

 

The Diagnostics button opens the Diagnostics 
dialog box, which lets you test your software and 
view call statistics.  

 

 

The Communications button opens the 
Communications window, which lets you enable or 
disable ISDN communications.  

The Preferences button modifies various 
application features. 

 

Status Line 
The Status Line in the Main toolbar provides information about the current status of your Live200 system.  

 

Call Menu 
The Call menu provides the following options:  

• Make call opens the Make Call dialog box, which lets you make an audio, video and data call. 
• Hang up disconnects a video, audio, or data call. 
• Address Book opens the Address Book window, which provides flexible telephone directories for 

storing phone numbers and other information about other individuals. 
• Exit closes the Live200 application. 



 

 

 

Hotlist Menu 
The Hotlist menu lets you speed-dial a list of frequently-called phone numbers and access previously dialed 
numbers.  

• Add to Hotlist adds a person's name and phone number to the Hotlist menu.  
• Remove from Hotlist removes a person's name and phone number from the Hotlist menu.  

Most recently dialed numbers appear on this menu. 

 

 

Tools Menu 
The Tools menu provides the following options:  

• Preferences lets you customize the Live200 working environment.  
• Communications lets you change the type of protocol the ISDN transport uses.  
• Hardware Settings let you change your audio, video, audio compression, video compression, network, 

and data rate settings. You can also view information on the Live200 board, such as revision levels.  
• Call Log keeps a record of incoming and outgoing calls such as the name of the person, date, time, and 

duration of the call.  
• Diagnostics lets you test your software and view call statistics. 

 

 



Window Menu 
The Window menu provides the following options:  

• Local Video lets you open the Local Video window, which displays the video image you are sending to 
your calling partner. If the window is already displayed, then it brings it to the front. 

• Remote Video lets you open the Remote Video window, which displays the video image your calling 
partner is sending to you. If the window is already displayed, then it brings it to the front. 

 

 

Help Menu 
The Help menu lets you access online help for all Live200 functions, and provides the version number of the 
program.  

 

  



Navigating Within the Video Windows 
 

Overview 
You can navigate within the Live200 video windows by using the video windows' toolbars and menus. The 
toolbars contain buttons and menu commands that you can use to immediately access all Live200 video window 
functions. 

Click the following links for additional information:  

• Local Video Window 
• Local Video Camera 
• WorldCam 
• FlipCam 
• Local Video Window Toolbar 
• Snapshots 
• Additional Local Video Window Toolbar Buttons 
• Local Video Window Menus 
• Remote Video Window 
• Remote Video Camera 
• Remote Video Window Toolbar 
• Additional Remote Video Window Toolbar Buttons 
• Remote Video Window Menus 
• Arranging Your Video Windows 
• Selecting the Video Source 
• Turning Off Your Video Camera 
• Adjusting Your Audio Level 

 

Local Video Window 
The window that displays the video image you are sending to your calling partner is called the Local Video 
window. You can view the image that you are sending before and during a video call.  

 



 

Local Video Camera 
You send a video image to your calling partner by using the local video camera, like a WorldCam, FlipCam, or 
any other type of video camera. You can also use Live200's optional dual-input video cable to connect another 
video source, such as a document camera.  

You can tilt the camera to center the image you are sending. If you are using a camera that does not have 
control buttons on it, you can increase or decrease the brightness level of your video image using the buttons in 
the Local Video window toolbar. You can also adjust the color and contrast levels by adding these buttons to 
the Local Video window toolbar or by adjusting their sliders using the Video tab of the Hardware Settings 
dialog box.  

You can also make adjustments from the Windows NT Control Panel. See Changing Your System Settings in 
the online help for information.  

 

WorldCam 
If you are using the WorldCam camera, adjust the focus using the Focus knob on the camera. You increase or 
decrease the brightness level of the image using the Contrast buttons on the camera. It is recommended that you 
keep the brightness and contrast sliders in the Video Settings sheet at the default positions and adjust the video 
image using the controls on the WorldCam.  

When you turn on the WorldCam, it powers up in manual exposure mode. For most videoconferencing 
situations, manual mode is preferred. However, you can switch the camera to automatic exposure mode by 
pressing the two Contrast buttons at the same time. Pressing the Contrast buttons switches the camera between 
manual and automatic mode. When the camera is in automatic mode, it compensates for large variations in 
lighting. However, this can slow down the video frame rate and decrease the quality of the video image. It is 
recommended that you operate the WorldCam in manual mode for the optimum video image.  

 

FlipCam 
If you are using the FlipCam camera, adjust the focus lever marked  to sharpen the focus. To widen or 
narrow the camera's field of view, adjust the zoom lever marked . When you change the zoom setting, you 
usually must refocus as well. To lighten or darken the picture, adjust the brightness (iris) lever, marked .  

 

Local Video Window Toolbar 
You can use the following buttons in the Local Video window toolbar to immediately access a feature. Each 
button is a shortcut way of choosing a menu item.  



Toolbar Description  

 

The Image Size box lets you automatically resize the Local Video window. The 
choices are Small, Medium, and Large. If you manually resize this window by 
dragging the bottom right-hand corner, the video window dimensions are 
displayed in the box. You can also set the default sizes for Small, Medium, and 
Large in the Video Window sheet from the Preferences dialog box. 

 
The Increase Brightness button increases the balance of light and dark shades of 
your image in the Local Video window. 

 
The Decrease Brightness button decreases the balance of light and dark shades in 
the Local Video window. 

 
The Snapshot button lets you take a still image, similar to an electronic 
photograph and displays it using the Windows Paint application.  

 

The Select Video Source button lets you choose which local video source you 
want to send. For example, you might want to use another camera to focus in on 
the details of a document. This button lets you select the document camera as the 
video source. 

 

Snapshots 
A snapshot is a still image similar to an electronic photograph. You can take a snapshot from the Local and 
Remote Video windows and include the snapshot in the Address Book.  

When you click the Snapshot button the current image in the window is captured as a still image and is 
displayed in the Windows NT Paint application. Each time you click the Snapshot button or choose Snapshot 
from the menu, a window appears displaying the new snapshot. You can edit the snapshot using the Paint 
editing tools.  

 

Additional Local Video Window Toolbar Buttons 
You can add the following buttons to the Local Video window toolbar using the Toolbar sheet in the 
Preferences dialog box. See the online help or Setting Preferences for more information.  

Toolbar Description 

 
The Increase Contrast button increases the range between the lightest tones and 
the darkest tones of your image in the Local Video window. 

 
The Decrease Contrast button decreases the range between the lightest tones and 
the darkest tones of your image in the Local Video window. 

 
The Increase Color button increases the color mixture of your image in the Local 
Video window. 

 
The Decrease Color button decreases the color mixture of your image in the Local 
Video window. 

 



Local Video Window Menus 
You can use the menu bar within the Local Video window to access the following menus:  

Menu Description 

 

The Image menu provides the following options that let you change the size 
of the Local Video window:   

• Small  
• Medium  
• Large  

You can also change the size of the Local Video window by dragging the 
lower right-hand corner of the window border. Live200 provides an aspect 
ratio similar to your monitor's aspect ratio. The aspect ratio is the relationship 
between width and height. 

 

The Camera menu provides the following options:   

• Snapshot takes a snapshot of the image in the Local Video window.  
• Select Video Source lets you select the video source to use during a 

call.  

 

Remote Video Window 
The window that displays the video image of your calling partner is called the Remote Video window. Once 
you are connected, and your calling partner answers your call, the Remote Video window appears on your PC.  



 

You can change the size of the Remote Video window by dragging the lower right-hand corner of the window 
border.  

 

Remote Video Camera 
If you are calling a system that supports H.281 far end camera control, such as a PictureTel group system, you 
can adjust the remote camera, provided the camera has pan/tilt/zoom (PTZ) capabilities.  

You can use the Remote Camera Control Preset buttons to associate the remote camera position with a 
button. For example, if you are in a call where you are using a whiteboard to present information, you can 
preset a button so that when it is clicked, the camera focuses on the whiteboard. This saves time since you do 
not have to adjust the camera in the middle of the call.  

The preset locations are saved on the remote video camera, not on your PC. Therefore, it is possible for your 
calling partner to change the settings for a preset number that you might have set during the current call or a 
previous call. If you are in a call with a group system, it is also possible that your ability to change the remote 
camera's preset number buttons might be disabled. The Remote Camera Control Preset buttons do not appear in 
the Remote Video Window if the remote system does not support remote camera control or has disabled it. The 
Remote Camera Preset buttons need to be set on each system being used. 

 

Remote Video Window Toolbar 
You can use the following buttons in the Remote Video window toolbar to immediately access a feature. Each 
button is a shortcut to choosing a menu item.  



Toolbar Description 

 

The Image Size box lets you automatically resize the Remote Video 
window. The choices are Small, Medium, and Large. If you manually 
resize this window by dragging the bottom right-hand corner, the 
window dimensions are displayed in the box. You can also set the 
default sizes for Small, Medium, and Large in the Video Window sheet 
from the Preferences dialog box. 

 
The Hang up button disconnects a video, audio, or data call. 

 

The Audio Off button lets you turn off the microphone so that your 
calling partner cannot hear you or local conversations. A red circle 
means off. 

 

The Video Off button turns off the video image so that your calling 
partner cannot see you. When you turn off your video the image in the 
Local Video window is black. A red circle means off. 

 
The Snapshot button takes a still image, similar to an electronic 
photograph and displays it using the Windows Paint application. 

 

The Remote Camera Control button lets you pan, tilt, and zoom the 
remote camera when calling a remote system that supports remote 
camera control, such as a PictureTel group system. You can also use 
the mouse to control the remote camera. 

 

The Volume control slider lets you adjust the volume of the audio that 
you are receiving from the your calling partner. Sliding the control to 
the left decreases the volume. Sliding the control to the right increases 
the volume. 

 
The Call duration counter records the length of time of your call by 
displaying the hours, minutes, and seconds. 

 

The Remote Camera Control preset buttons appear when the camera 
at the far end supports H.281 far end camera control. You can associate 
a remote camera position with a button. When you click a preset button 
the camera automatically focuses on the position that you set. 

 

Additional Remote Video Window Toolbar Buttons 
You can add the following buttons to the Remote Video window toolbar using the Toolbar sheet in the 
Preferences dialog box. See the online help or Setting Preferences for more information.  

Toolbar Description 

 
The Audio/Video Mute button turns on/off both the microphone and the camera so 
that your calling partner cannot hear or see you. 

 

The Select Video Source button lets you choose which remote video source you 
want to receive. For example, your calling partner might want to use another 
camera to focus in on the details of a document. This button lets you choose a 
document camera as the remote video source, if your calling partner has more than 
one connected. 



 

Remote Video Window Menus 
You can use the menu bar within the Remote Video window to access the following menus:  

 

The Call menu provides the following options:   

• Hang up disconnects a video, audio, or data call.  
• Audio Off turns off the microphone so that your calling partner 

cannot hear local conversations.  
• Video Off turns off the video image so that your calling partner 

cannot see you.  

 

The Image menu provides the following options that let you change the 
size of the Remote Video window:   

• Small  
• Medium  
• Large  

You can also change the size of the Remote Video window by dragging 
the lower right-hand corner of the window border. 

 

The Camera menu provides the following options:   

• Snapshot takes a snapshot of the image in the Remote Video 
window and displays it in the Windows NT Paint application.  

• Select Video Source lets you select the video source to use during 
a call.  

• Move Remote Camera lets you adjust the remote camera, 
provided the camera supports H.281 far end camera control.  

 

Arranging Your Video Windows 
You can resize and save the position of the Local and Remote Video windows. You can automatically resize the 
windows by selecting either Small, Medium, or Large from the Image Size box in the Local Video or Remote 
Video windows. You can manually resize the windows by dragging the lower right-hand corner of the window 
border.  

 



Selecting the Video Source 
You can select the video source you want to use during a call by clicking the Select Video Source button or 
choosing Select Video Source from the Camera menu in the Local Video or Remote Video windows. When 
you are in the Local Video window, you can select the local video source. When you are in the Remote Video 
window, you can select the remote video source. For example, you might want to switch to a document camera 
during the call.  

 

Turning Off Your Video Camera 
You can turn off your video camera by clicking the Video Off button or choosing Video Off from the Call 
menu in the Remote Video window. If you are using the WorldCam or the FlipCam, you can also close the 
privacy shutter on the front of the camera so that the your calling partner cannot see your image.  

 

Adjusting Your Audio Level 
You can adjust the audio level you receive from your calling partner by clicking the volume control in the 
Remote Video window. You can turn off the audio you are sending by clicking the Audio Off button in the 
Remote Video window or by clicking Audio Off from the Call menu. 
 



Address Book Lists 
 

Overview 
Address book lists are flexible telephone directories that let you automatically make calls without having to 
manually dial numbers. You can create one or more address book list. Each list can contain entries that have an 
individuals name, address, phone number, and other connection information. 

Click the following links for additional information: 

• Address Book Window 
• Converting Live50/100 Address Book Lists 
• Address Book Toolbar 
• Add Person Window 
• Connections Information 
• Address Book List Dialog Box Toolbar 
• Hotlists 

 

Address Book Window 
The PictureTel Address Book window displays your first and last name, and ISDN number the first time you 
open it. 



 

After you open the Address Book window, you can create an address book list and start adding entries. 
Information on a specific individual in an address book list is called an entry. Each address book list can have 
an unlimited number of entries. Address book lists are given a .PTA extension and are stored in the location you 
specify. If you want Caller ID to identify incoming calls, the number must be listed in an address book list. You 
can specify that you want to use dialing prefixes in either the Address Book window, the Make Call dialog box, 
or in the Call tab of the Preference dialog box. 

You can store an address book list as a shortcut on your Windows NT desktop or on a shared network drive. 

 

Converting Live50/100 Address Book Lists 
You can convert address book lists from your Live50/100 systems to the Live200 format using the ABconverter 
program located in the \Program Files\PictureTelNT\LiveWare directory. Double-click the ABconverter icon 
and follow the instructions on the screen. 

 

Address Book Toolbar 
You can use the following buttons in the toolbar of the Address Book window to immediately access a feature. 
Each button is a shortcut way of choosing a menu item.  

 The New button creates a new address book list.  



 The Open button opens an existing address book list.  

 
The Cut button lets you cut information to the clipboard. This 
information may be pasted in another location. 

 
The Copy button lets you copy information from one location to 
another. 

 
The Paste button lets you paste information that you have 
previously cut to the clipboard. 

 
The Add New Person button lets you add a new entry to an 
address book list.  

 The Print button prints the contents of an address book list.  

 

Add Person Window 
When you add a new person to your Address Book, you enter their information in the Add Person window. 
Because you can create or update an Address Book that you can also use on Live200 for Windows 95, you can 
load or paste an image into an Address Book. However, the images that you load or paste into an Address Book 
using Live200 for Windows NT do not appear in the Live200 for Windows NT Image bar during a conference. 

 



 

Connections Information 
Although the primary purpose of the Address Book is to store numbers and to connect to your calling partner, 
you can also use it as your central telephone directory for all your contacts. An Address Book can contain 
information for connection types that might not be supported by PictureTel Live200 for Windows NT.  

The connection type you choose determines the additional connection information you enter. For ISDN and 
modem connections you enter phone numbers. For TCP/IP, NetBIOS, or IPX connections, you enter addresses. 
You can add more than one connection per entry. For example, your caller might have a residential as well as a 
business ISDN line, or a local and overseas ISDN line. You might also want to add a connection using another 
network transport, such as TCP/IP. 

 

 

Address Book List Dialog Box Toolbar 
You can use the following buttons in the toolbar of the Create New and Open Address Book List dialog boxes 
to immediately access a feature. Each button is a shortcut to choosing a menu item. 

 
The Up One Level button displays the directory level above the 
currently displayed level.  

 
The Create New Folder button creates a folder in which you can 
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name for a folder.  

 
The List button displays only the file names of address book lists in 
the Create and Open Address List dialog boxes.  

 

The Details button displays the Size, Type, and Modified date of 
each address book list in the Create and Open Address List dialog 
boxes.  

 

Hotlists 
You can create a list of your most frequently dialed numbers using the Hotlist menu. You can then 
automatically speed-dial a call to an individual by clicking the Hotlist button or choosing Hotlist from the Main 
toolbar and clicking the number from the hotlist. You can set the number of entries that appear in the Hotlist 
menu from the Call tab of the Preferences dialog box. 
 



Data Collaboration 

 
Overview 
Live200 for Windows NT uses Microsoft NetMeeting 2.0 or greater to support T.120 point-to-point and 
multipoint data collaboration. Microsoft NetMeeting enables real-time communication and data collaboration 
providing windows-based audio, video, and multipoint data conferencing support. Users can share data through 
application sharing, electronic whiteboard, file transfer and text-based chat, all of which can be used in Live200 
for Windows NT. 

Click the following links for additional information: 

•   Live200 and Microsoft NetMeeting  
•   How to access Microsoft NetMeeting for use with Live200  
•   Setting up and using Microsoft NetMeeting with Live200  

 

Live200 and Microsoft NetMeeting  
Microsoft NetMeeting provides support for audio, video and data calls over a LAN, but does not support 
placing H.320 calls directly. The Live200 software provides an H.320 transport to allow NetMeeting to setup 
T.120 conferences over a Live200 H.320 call. To do this, PictureTel provides a new transport driver for 
NetMeeting called PictureTel Live. The Live200 application automatically configures NetMeeting to use this 
transport. When you place a call from the Live200 application, you can choose Audio/Video/Data in the Make 
Call dialog which will automatically trigger a NetMeeting T.120 connection over the H.320 call.  

References to audio and video within NetMeeting are not used as part of the Live200 integration.  

 

How to access Microsoft NetMeeting for use with Live200 
NetMeeting is available as a free software download from Microsoft. If you do not have NetMeeting installed 
already, you can down load the latest release of Microsoft NetMeeting for Windows NT from the Microsoft 
web site, http:\\www.microsoft.com. Follow the instructions on the Microsoft web site to select the correct 
version for Windows NT.  

 



Using Microsoft NetMeeting with Live200 
To host a NetMeeting application sharing session you must have the Windows NT Service Pack 3 (or later) 
installed. To find out if you have a service pack installed and which version it is, open Windows Explorer and 
select About Windows NT from the help menu. If a service pack has been installed, you will see it listed after 
the version and build number in the About Windows NT dialog box. You can access the latest service pack on 
the Microsoft web site, http:\\www.microsoft.com.  

The following diagram illustrates the integration of Netmeeting and the Live200 for Windows NT. 

 



Setting Preferences 
 

Overview 
PictureTel Live200 preference settings let you customize the applications's working environment. For example, 
you can customize toolbars by adding the buttons that you use the most. Once you select your preferences, they 
remain in effect from one calling session to the next, until you change them. 

Click the following links for additional information: 

• Preferences Dialog Box 
• General Preferences 
• Call Preferences 
• Video Window Preferences 
• Toolbar Preferences 
• Customizing the Toolbars 
• Spacing between Toolbars 
• Local Video Window Toolbar 
• Remote Video Window Toolbar 
• Menu Preferences 
• Data Sharing 

 

Preferences Dialog Box 
Choose Preferences for the Tools menu in the Main toolbar or click the Preferences button (if you added this 
button to the toolbar). 



 

The Preferences dialog box provides access to the General, Call, Video Window, Toolbar, Menu, Data Sharing 
Preferences sheets. 

 

General Preferences 
Click the General tab to display the General Preferences sheet. General preferences let you: 

• Retain windows sizes and positions  
• Position the PictureTel Live200 Main toolbar  
• Set the preferences for Caller identification 



 

The following General Preferences are available from the Windows group: 

• Save main toolbar position and size between sessions lets you save the main toolbar and video 
window sizes and positions from the last time you accessed the Live200 application. 

• Main toolbar always on top prevents other windows from covering the main toolbar. The default 
setting is Off.  

• Caller identification identifies incoming calls with the name of the caller if the caller is listed in an 
Address Book list.  

The following Caller identification preferences are available: 

• The Add button opens a dialog box that lets you select an Address Book list to use for incoming calls. 
By searching an Address Book list, Live200 can provide you with the name and number of your caller 
before you answer the incoming call.  

• The Remove button removes the Address Book lists that you highlight in the list box.  
• The Remove all button removes all Address Book lists that appear in the list box.  

 

Call Preferences 
Click the Call tab to display the Call Preferences sheet, which lets you: 

• Set a dialing prefix  
• Set your computer to automatically answer incoming calls  
• Set the ringer volume  



• Set Dialing Properties  
• Modify how many phone numbers you want listed in the Hotlist menu.  

 

The following Call Preferences are available: 

• The Use dialing prefix check box lets you add a number that is dialed before all phone numbers. If you 
enter that number as the phone number prefix, you do not have to manually dial it before each call.  

• Click the Dialing Properties button to open the Dialing Properties dialog box, which lets you set and 
automate dialing prefixes. 



 

For example, you might have to dial a number, such as 9, before making a call. To use a dialing prefix, 
enter the prefix in the appropriate box. When you make a call, you just dial the 7-digit number and the 
prefix is automatically included. If you are using dialing prefixes, you do not need to enter them when 
you create an entry in an Address Book list. 

• The Auto answer incoming calls check box lets your computer automatically answer all incoming 
calls, without you having to be present. 

• The Ringer sound enabled checkbox lets you turn off the ringing signal that alerts you about an 
incoming call.  

• The Ringer volume slider lets you increase or decrease the ringer volume, which rings when you have 
an incoming call. You can adjust the ringer volume for external speakers, such as the multimedia 
speakers or the earpiece, through the Call Preferences tab. You cannot adjust the ringer volume for 
speakers that are internal to the PC. 

• The Number of entries in the most recently called list allows you to enter the number of recent calls 
displayed in the Hotlist menu. You can select a number from 1 to 10. 

 

Video Window Preferences 
The Video Window Preferences sheet lets you automatically reposition and size the Local Video and Remote 
Video windows to optimize your videoconferencing desktop. 



 

The following Video Window preferences are available from the Window resizing group: 

• Size for best video image provides an aspect ratio similar to your monitor's aspect ratio for the Local or 
Remote Video windows. The aspect ratio is the relationship between width and height.  

• Permit any size window allows any size for the Local or Remote Video windows. The maximum 
resolution of your video image is determined by the type of monitor you are using. 

The following Video Window Preferences are available from the Window stacking group: 

• Remote video window always on top keeps other windows from covering the Remote Video window.  
• Local video window always on top keeps other windows from covering the Local Video window.  

The Video window size group provides screen size sliders that let you customize the vertical and horizontal 
measurements of the Small, Medium, and Large selections from the Image listbox in the Local Video and 
Remote Video windows. 

 

Toolbar Preferences 
The Toolbar Preferences sheet contains the Main toolbar preferences. It lets you create custom toolbars for the 
Main toolbar, the Local Video window toolbar, and the Remote Video window toolbar. 



 

 

Customizing the Toolbars 
To customize the toolbar use the following functions: 

• The Select toolbar listbox lets you select the toolbar to customize. 
• The Button size option lets you determine the size of the toolbar buttons. 
• The Toolbar group contains the buttons that are currently in the Main toolbar. You can add and remove 

these buttons by following the instructions in the next section. 
• The Buttons group contains buttons that you can add to the Main toolbar by dragging and dropping 

them into the Toolbar group.  

 

Spacing between Toolbar Buttons 
You can move, remove, and change the spacing between any buttons on a toolbar as follows: 

• Move a button in the Toolbar group by dragging and dropping it to a new location and clicking Apply.  
• Delete a button in the Toolbar group by dragging and dropping the button outside the group. It then 

appears in the Button group. Click Apply to save your changes.  
• Add a space between toolbar buttons by dragging the button away from another button. Remove a space 

between toolbar buttons by dragging the button toward another button. Click Apply to save your 
changes.  



 

Local Video Window Toolbar 
If you select Local Video from the Select Toolbar listbox the Local Video window toolbar buttons appear: 

 

 

Remote Video Window Toolbar 
If you select Remote Video from the Select Toolbar listbox the Remote Video Window toolbar buttons appear. 



 

 

Menu Preferences 
Click the Menu tab to display the Menu Preferences sheet. You can customize Live200 menus so that they 
contain the commands that you use most often. 



 

The following options are available: 

The Available commands group provides a listing of commands that you can assign to any menu listed in the 
Menu group. Commands can be assigned to more than one menu. The Description box gives you information 
about each command.  

• To add a command to a menu, select and item and drag and drop it onto a menu in the Menu list.  
• To remove a command from a menu, drag the selected command off the Menu list and drop it anywhere 

on the screen.  
• Select the Separator to place a horizontal line between menu items. The Menu group provides a list of 

the Live200 Main toolbar menus.  
• You can click on any menu in this listing and edit and rename its text. Click the + (plus) sign to expand 

the submenus.  
• An & symbol (ampersand) indicates the placement of an underbar for a shortcut key. Positioning the 

ampersand to the left of a letter assigns the underbar to that letter.  
• You can move any menu by dragging and dropping it.  
• You can delete any menu by dragging and dropping it outside of the group.  

 

Data Sharing 
Click the Data Sharing tab to display the Data Sharing Preferences sheet. Use these preferences to indicate that 
you want Microsoft NetMeeting to start automatically when you start the Live200 application. 



 

Start Microsoft NetMeeting when the PictureTel application is started automatically starts NetMeeting 
when you start the Live200 application. Any changes to this option take effect the next time the Live200 
application is started. 
 



Troubleshooting  
 

Overview 
You can troubleshoot your PictureTel Live200 system using the two types of diagnostic tools provided with the 
Live200 application:  

• Use the Diagnostics window for viewing error logs, performing loopback tests, and getting statistical 
information about the PictureTel Live200 application's software.  

• Use the PictureTel LiveTest Hardware Diagnostic application for testing major circuit elements of the 
videoconferencing hardware installed in your system.  

The test results from these tools help your PictureTel service provider find a solution to a problem. For 
example, you might need a replacement board.You can also contact technical support using any of the 
methods described in the Contacting Technical Support section. 

Step-by-step instructions about using Live200 operations, commands, and menu options are in the online help.  

Click the following links for additional information: 

• Diagnostics Window 
• Error Log 
• Version 
• Tests 
• Statistics 
• LiveTest Hardware Diagnostic Application 
• Contacting Technical Support 

 

Diagnostics Window 
Choose Diagnostics from the Tools menu in the Main toolbar, or click the Diagnostics button (if you added this 
button to the toolbar) to access the Diagnostics dialog box. This dialog box lets you view errors, run a loopback 
test for testing your Live200 system, view statistics about your system, and check the versions of software you 
are running.  

The functions from the Diagnostics dialog box do not test the major circuit elements in the PictureTel Live200 
system. It tests the software elements. See the section entitled Using the Diagnostic Application for information 
about testing circuit elements. 

 



Error Log 
An error log contains a chronological collection of errors that are useful when calling your PictureTel service 
provider. The information in the Error Log sheet is recorded in the ELOGCURR file, which is located in the 
LiveWare folder in the folder in which you installed PictureTel Live200. This file stores up to 100K of 
information. Once the 100K limit is reached, the information in the ELOGCURR file is copied to the 
ELOGPREV file. This action ensures space for new information in the ELOGCURR file. 

You can print or view both of these files using the Windows NT Notepad or WordPad applications in the 
Accessories folder. 

 

• Filter opens the Filter Error Messages dialog box, which lets you select the type of errors you want to 
display. 

• Save As saves the error log as a file. 
• Clear clears all messages in the error log. 
• Test runs a test to ensure that the error log is working properly. 

 



Version 
You can get the serial number and version number of any file installed by PictureTel Live200 on your hard 
drive. This information is useful when calling your PictureTel service provider. 

To get serial and version numbers for Live200 file: 

Click the Version tab in the Diagnostics dialog box. 

 

To save the version number information to a .TXT file: 

Click the Save button in the Version sheet. 

 

Tests 
You can use the Test sheet to make a video call to yourself, referred to as a loopback, for video, audio, and 
ISDN testing purposes. 

To access the Test sheet: 

Click on the Tests tab in the Diagnostics dialog box. 



 

• Select a connection type lists the connections upon which you can run a loopback test. 
• Select a test to perform lists the tests from which you can choose 
• Test Results displays the outcome of the test you ran. 
• Start Test runs the test that you selected. 
• Stop Test stops the test you selected from running. 

 

Statistics 
You can use the Statistics sheet to view statistics about your Live200 system. When you select an item from the 
list, the Summary statistics box displays the current call information. To refresh the statistic information after it 
has been displayed, click the Refresh Statistics button. 



 

•   Select a connection type lists the connections for which you can display statistics.  
•   Summary statistics displays a summary of the statistics for the connection type you chose.  
•   Statistics details displays the statistic details for the connection type you chose.  
•   Refresh statistics refreshes the statistics fields when you choose a new connection type.  

 

LiveTest Hardware Diagnostic Application 
The PictureTel LiveTest Diagnostic application is a standalone Windows NT application that you can use to test 
major hardware elements. You can test the Live200 board for any problems. All data paths and components are 
tested by addressing, reading, and writing registers and memory locations. The physical and functional integrity 
of the PCI bus interface is also tested. 

The LiveTest application does not test the PictureTel Live200 software or the attached ISDN network. To test 
your PictureTel Live200 software, see the section Diagnostics Window, earlier in this chapter. 

The LiveTest application performs a pass or fail test of the Live200 board. While it runs, it records all messages 
in an error log file. You can provide your PictureTel service provider with a hard copy of this log should your 
Live200 board need repairing. 

To run the LiveTest application: 

1. Close all videoconferencing applications, including Live200 and NetMeeting.  
2. Double-click the LiveTest.EXE file located in C:\Winnt\Live200\Diagnostics. 

 
The LiveTest Hardware Diagnostics dialog box appears. 



 

 
To run board tests: 

3. Click the Start Testing button. 
 
The diagnostic application tests the Live200 board. The Test Status box lists the name of the current test, 
and the progress indicator bar displays the approximate percentage of the tests completed. You can stop 
the test at any time by clicking the STOP button. When the tests are done, the Tests Failed count should 
be zero. 

 



4. Click the Board ID button to get information on the board, such as the revision number, serial and part 
numbers, and last failure. This imformation is necessary when calling Customer Support. 

 
5. Click the Camera Test button to view the camera output. 

The Camera Test dialog box appears, where you can visually check the video image quality the camera 
is transmitting.  

Click the OK button to close the Camera Test dialog box. 

6. Click the Audio Test button to check the speaker and microphone or speakerphone if it is installed. 
 
The Audio Test dialog box appears. 

 
7. Click the Error Log button to view the error log. The log contains a sequential listing for each of the 

failed tests, including test name and the status of each test. The log is saved as a text file called 



Errorlog.txt. You can print the log using the Windows Notepad 

application.  

WARNING 

After running the diagnostic program, you must reboot the computer before running any 
videoconferencing application. Otherwise, you will not be able to make a call.  

 

Contacting Technical Support 
PictureTel's Web page includes information about the PictureTel corporation, products and user groups, as well 
as information about contacting Customer Service. You can also download software updates and patches from 
the web page. Point your browser to: 

http://www.picturetel.com 

Customer Service BBS 

PictureTel's Customer Service Bulletin Board (BBS) is a dial-in BBS that provides Customer Service 
information through a modem. Access the BBS to download files, to perform keyword searches on text or 
software files, and to exchange messages with the system operator. 

System Requirements to Access BBS 

• PC  
• Communication (terminal emulation) software  



• Modem with a minimum 14.4 kbps transmission rate  
• ANSI graphics  
• Multiple transfer protocols  

Accessing the BBS 

To access the PictureTel BBS: 

1. Run the communication software.  
2. Set terminal configuration to (8) data bits, No parity, (1) stop bit.  
3. Dial the following modem number. (If calling from outside the US, add the country code of 1.)  

978-292-3350 
 
When the mode connects, the Welcome screen appears and prompts you for your full name. 

FAX Back 

PictureTel's FAX Back service offers a wide variety of taxes with technical tips and troubleshooting 
information. With a touch-tone phone, call: 

800-783-5411 

Follow the voice prompts to order a FAX back document. 
 



Hardware and Communication Settings 
 

Overview 
You can change your video, audio, application sharing, and network settings and view board information, such 
as revision levels. Some of these settings are automatically set during installation. You can also enable, disable, 
and reconfigure network transports. You might need to consult your network provider when modifying network 
settings. 

Click the following links for additional information: 

• Video Bandwidth 
• Changing Hardware Settings from the Control Panel 
• Changing Hardware Settings in PictureTel Live200 
• Video Settings 
• Video Compression Settings 
• Audio Settings 
• Audio Compression Settings 
• Data Rate Settings 
• Network Settings 
• Board Info Settings 
• Communication Settings 

 

Video Bandwidth 
The amount of channel bandwidth that is allocated to video has a great impact on the video quality. The video 
transmit bandwidth is determined by the remaining bandwidth after the audio and data portions of the call are 
allocated. Thus, the audio and data bandwidth settings are important in controlling the video quality. You can 
select the audio compression and data rate formats through the Hardware Settings dialog box.  

In a normal office situation, where you are sitting in one position and moving very little, leave the SmartPick 
setting on the Audio Compression sheet at the default setting of selected and leave the Maximum Rate setting 
on the Data Rate sheet at the default of High and the Control Method at the default of Dynamic . In a situation 
where there is motion, change the Audio Compression setting to G.728 by clearing the SmartPick check box 
and selecting G.728 from the Preferred Compression Scheme and change the Data Rate setting to Off. Make 
sure that your calling partners' systems are also set to G.728. 

 



Changing Hardware Settings from the Control Panel 
You can change your hardware settings before running PictureTel Live200 using the Live200 Hardware 
Settings applet in the Control Panel. Changes you make take effect when you restart PictureTel Live200 or 
when you reboot. 

To open the Live200 Settings applet: 

1. Click the Start button from the Windows NT desktop.  
2. Click Settings from the Start menu.  
3. Click Control Panel from the Settings menu.  
4. In the Control Panel, click the Live200 applet . 

 

The Live200 Settings dialog box appears.  

 

Changing Hardware Settings in PictureTel Live200  
You can change your hardware settings when running PictureTel Live200. Changes you make take effect the 
next time you start PictureTel Live200 or in the next call. 

To open the Hardware Setting dialog box in PictureTel Live200: 

Choose Hardware Settings from the Tools menu in the Main toolbar or click the Hardware Settings 
button (if you added this button to the toolbar).  

The Hardware Settings dialog box appears with the Video sheet displayed.  

 

Video Settings 
Click the Video tab to display the Video sheet. The controls in this sheet let you adjust your video camera 
settings, which you can preview in the Local Video window. 



 

The following options are available in the Picture Controls group: 

• The Allow DirectDraw Optimization specifies that DirectDraw optimization is used, if your system 
has a video card with DirectDraw capabilities that Live200 can work with. 

• The Brightness control slider lets you adjust the balance of light and dark shades of your image in the 
Local Video window. You can adjust the brightness level during a video call.  

• The Color control slider lets you adjust the color mixture of your image in the Local Video window. 
You can adjust the color level during a video call.  

• The Contrast control slider lets you set the range between the lightest tones and the darkest tones of 
your image in the Local Video window. You can adjust the contrast level during a video call.  

• The Preview button lets you temporarily see the changes you make by displaying the Local Video 
window.  

 

Video Compression Settings 
Click the Video Compression tab to display the Video Compression sheet. PictureTel Live200 compresses 
video signals so that they can be sent over ISDN phones lines. The signals are decompressed at the receiving 
end and presented as motion video. Any changes you make to video compression take effect the next time you 
make a video call. For the settings to take effect immediately, adjust the Video Compression Quality slider 
before making a video call. 



 

The settings for the Video Compression Quality slider determine the video quality that you transmit to other 
individuals. This control does not affect the video quality that you receive. 

• Dragging the slider towards Smooth Motion increases the smoothness of the frame transmission rate for 
the video. When the slider is in the left two positions video is transmitted in in Quarter Common 
Intermediate Format (QCIF). QCIF provides a video resolution of 176 by 144 lines.  

• Dragging the slider toward Sharp Picture increases the detail in a single video frame, which sharpens 
the video resolution. When the slider is in the right two positions, video is transmitted in Common 
Intermediate Format (CIF). CIF provides a video resolution of 352 pixels in each of 288 non-interlaced 
lines.  

• The Preview button lets you temporarily see the compression quality by displaying the compressed 
video in a window. When you click the Preview button, the message "Starting Preview" appears. The 
window appears with a preview of your image. When you are finished adjusting the compression 
settings, click the Close button to close the window.  

 

Audio Settings 
Click the Audio tab to display the Audio sheet. These settings affect the sound that your calling partner hears. 



 

The Audio Input Device is initialized during installation. The default setting for this category is Auto. 

• Click Auto to have the system automatically detect your audio device.  
• Click Microphone if your audio input device is a microphone. For example, you can use the earpiece or 

external microphone that is packaged with PictureTel Live200, or a microphone from another 
manufacturer.  

• Click Line if your audio input is not a microphone. For example, you can use the line-out connection 
from a PictureTel speakerphone, CD player, VCR, or cassette player.  

• The Ring Output is initialized during installation. The default setting is Internal Computer Speaker. 
• Click Live200 Earpiece or Speaker if you want the ringer to sound from the earpiece or multimedia 

speakers that are packaged with PictureTel Live200.  
• Internal Computer Speaker sends the ringer to the internal speaker in your computer. This option does 

not support built-in multimedia speakers. You can adjust the ringer volume for external speakers, such 
as the multimedia speakers or the earpiece, through the Call Preferences tab. You cannot adjust ringer 
volume for speakers that are internal to the PC. 

The following options in the Smart Features group are turned on by default: 

• The Noise Reduction check box filters our certain background noises, such as the noise from air 
conditioners or ventilation systems.  

• The Automatic Gain Control check box lets the system keep the input speech signals from the 
microphone at a constant level. For example, when you back away from the microphone, your calling 
partner detects no difference in volume.  

 



Audio Compression Settings 
Click the Audio Compression tab to display the Audio Compression sheet. 

PictureTel Live200 compresses audio signals so they can be sent over ISDN phone lines. The signals are 
decompressed at the receiving end and converted into sound. 

 

The following options are available: 

• Click the Smart Pick checkbox to have PictureTel Live200 use the best audio compression method 
based on your calling partner's audio configuration.  

• If you want to select the compression method yourself, the Preferred Compression Scheme listbox 
provides the following choices:  

• PictureTel PT724 is a PictureTel standard scheme that can only be used with PictureTel products. It 
producers high-quality, wide-band audio using minimum bandwidth. The bandwidth requirement for 
this scheme is 24 kilobits per second. The frequency range is 50 to 7,000 Hz.  

• ITU-T Rec. G.728 is a standard that provides telephone-quality audio using the least amount of 
bandwidth. Not all videoconferencing systems support this scheme. The bandwidth requirement for this 
scheme is 16 kilobits per second. The frequency range is 300 to 3,400 Hz.  

• ITU-T Rec. G.722 is a standard that provides the highest quality wide-band audio. Not all 
videoconferencing systems support this scheme. The bandwidth requirement for this scheme is 48 to 56 
kilobits per second. The frequency range is 50 to 7,000 Hz.  

• ITU-T (International Telecommunications Union - T) Rec. G.711 A-law is a European standard that 
provides telephone-quality audio. The bandwidth requirement for this scheme is 64 kilobits per second. 
The frequency range is 300 to 3,400 Hz.  



• ITU-T Rec. G.711 Mu-law is a North America standard that provides telephone-quality audio. The 
bandwidth requirement for this scheme is 64 kilobits per second. The frequency range is 300 to 3,400 
Hz.  

The Lip sync option lets you determine whether audio and video are synchronized. For example, there is 
usually a slight delay between the sound you hear and the image you see. If you choose Enable Lip sync, you 
hear the audio at the same time you see the image. If you choose Fast Audio, you hear the audio as soon as 
possible, even if it is out of sync with the video. 

When you make an audio-only call, G.711 audio compression is used.The default voice coding is automatically 
set based upon the ISDN protocol being used. You can override the default by choosing one of the following 
Default voice coding options: 

• A-law - This is the preferred mode for calling in most European countires.Typically, most countries 
using the PAL video standards use A-law.  

• Mu-law - This is the preferred mode for calling in North America and some parts of Japan. Typically, 
most countries using the NTSC video standards use mu-law.  

 

Data Rate Settings 
Click the Data Rate tab to display the Data Rate sheet. 

 



You determine how much bandwidth you want to use for the data sharing portion of your call and whether you 
want that bandwidth to be fixed or to change. If you allocate a high amount of bandwidth for data, there is a 
quick response in the data sharing portion of the call. However, the more bandwidth you allocate to data the less 
that is available for video, which affects the quality of the video image. If you do not use data sharing, set the 
rate to Off. If you are using data sharing, it is recommended that you keep the Maximum Rate at the default of 
High and the Control Method at the default of Dynamic. 

The communication ports that are assigned to the Auxiliary port and the T.120 port appear on this sheet. 

 

Network Settings 
Click the Network tab to display your ISDN settings. Your network administrator or telephone company can 
provide you with the information needed for this sheet. 

 

Select the ISDN protocol that you want to use in the Protocol listbox. 



 

Your choices are as follows: 

• 5ESS Point-to-Point refers to the operation of one device on an ISDN line. With this service, only a 
single communications device is used for each BRI (Basic Rate Interface) line. This protocol is the 
default setting.  

• 5ESS Multipoint refers to the operation of multiple communications devices on an ISDN line. Service 
from a 5ESS Multipoint switch has one Service Profile Identifier (SPID) number.  
 
A SPID is a number assigned by your telephone company to each device connected to your ISDN line. 
SPIDs lets the telephone company know which ISDN services a given device can access. 
 
When you choose this protocol, the Channel One and Channel Two SPID boxes appears. These 
SPIDs are used to identify a specific ISDN set when more than one set has been attached to the same 
central office (CO) line. Your ISDN service provider can give you the SPID number. Do not use 
punctuation or spaces between digits when you enter the SPID. Make sure that you enter the SPID 
numbers correctly or you cannot make or receive calls. 

Select one of the following protocols if you are connected to a public network: 

o Net-3 for Italy 
o Net-3 for Norway  
o Net-3 for Singapore  
o Net-3 for Italy  
o Net-3 for Switzerland  
o Net-3 for Taiwan  
o Euro-ISDN  

 
When you select a Net-3 or Euro-ISDN protocol, the following sheet appears: 



 

The following options are available: 

The Multisubscriber No. 1 and Multisubscriber No. 2 (MSN) are for those switches outside the 
United States and Canada that permit multiple computers, each with a unique set of ISDN phone 
numbers, to be connected to a single line. To allow PictureTel Live200 to respond only to those 
incoming calls that are intended for your system, you must specify the MSNs that differentiate your 
system from other computers attached to the ISDN line.  

Number Type provides Unused, International, National, Network Specific, and Subscriber selections.  

Number Plan provides Unused, ISDN, Data (x.21), and Unknown selections.  

• NI1, DMS100  

If you choose NI1 or DMS100 the Channel One SPID and Channel Two SPID boxes appear. Service 
from these protocols have two Service Profile Identifier (SPID) numbers. The SPIDs are used to identify 
a specific ISDN set when more than one set has been attached to the same central office line. Your 
ISDN service provider can provide you with the SPID numbers. Do not use punctuation or spaces 
between digits when you enter the SPIDs. Make sure that you enter the SPID numbers correctly or you 
cannot make or receive calls. 

• NTT (Nipon Telephone and Telegraph)  



Channel One MSN and Channel Two MSN (Multiple Subscriber Number) boxes appear. MSNs are 
for those switches outside the United States and Canada that permit multiple terminals, each with a 
unique set of ISDN phone numbers, to be connected to a single line.  

• TPH1962  
• VN-3  
• 1TR6  

Select a number from the Number Type listbox. The numbering type is used for all calls. The type you 
choose is determined by the type of service you have. Your choices are as follows:  

• Unknown  
• International  
• National  
• Network Specific  
• Subscriber  
• Not used in listing 

Select a number plan from the Number Plan listbox. The numbering plan is used for all calls. This plan 
is determined by the type of service you have. You can obtain this information from your ISDN service 
provider. Your choices are as follows:  

• ISDN  
• Data (x.121)  
• Unknown  
• Not used in listing 

Select a number from the Number Type listbox. The numbering type is used for all calls. The type you 
choose is determined by the type of service you have. Your choices are as follows:  

• Unknown  
• International  
• National  
• Network Specific  
• Subscriber  
• Unused  

Select a number plan from the Number Plan listbox. The numbering plan is used for all calls. This plan 
is determined by the type of service you have. You can obtain this information from your ISDN service 
provider. Your choices are as follows:  

• ISDN  
• Data (x.121)  
• Unknown  
• Unused  

 



Board Info Settings 
Click the Board Info tab to display the settings for your Live200 board. This information can be useful if you 
need to call your PictureTel service provider. 

 

Note: The Serial Number and Part number may be unavailable. 

 

Communication Settings 
The Communications dialog box lets you reconfigure network transports.  

To open the Communications dialog box: 

Click Communications from the Tools menu in the Main toolbar or click the Communications button (if 
you added this button to the toolbar).  

The Communications dialog box appears with the ISDN sheet displayed. 



 

Make sure Enable communications is checked, so you can make video calls. When you click the Change 
Network Settings button, the Network sheet appears. See the section earlier in this chapter or the online help 
for more information on the Network settings sheet. 



Terminology 
 

Overview 
The following key terms explain the main aspects of Live200. The online glossary defines other terms that are 
useful in understanding Live200 functionality. You can access the online glossary from the online Help. 

Click the following links for additional information: 

• Videoconference 
• Networks and Protocols 

 

Videoconference 
• Bridge is a software-controlled switching device that interconnects multiple H.320-compliant 

videoconferencing systems. The term Multipoint Control Unit (MCU) is also used. To join a multipoint 
video conference, you and the other conference attendees dial into a bridge at a pre-arranged time.  

• Local Video window displays the image you are sending to your calling partner. You can adjust the 
brightness, contrast, and color of your image.  

• Remote Video window displays the image you are receiving from your calling partner.  
• Address Book lets you store, group (address book lists), and dial frequently called numbers.  
• Address book list is an individual database in the Address Book that contains names, phone numbers, 

and locations. You can share address book lists with others.  
• Hotlist lets you create a speed-dial list of your most-frequently dialed phone numbers.  
• Call log list lets you view a list showing the history of incoming and outgoing calls.  

 

Networks and Protocols 
• Integrated Services Digital Network (ISDN) is a telecommunication standard that is capable of 

sending digitally encoded voice, data, video, and other signals on the same lines.  
• Basic Rate Interface (BRI) is an interface between a user and an ISDN switch. The BRI specifies two 

64-kilobit per second (kbps) B channels (for voice and data) and one 16-kbps D channel (for customer 
and call information).  

• Internetwork Packet Exchange (IPX) is a network layer protocol responsible for addressing and 
routing packets to nodes on other networks.  

• Local Area Network (LAN) is a short-distance data communications network used to link together 
computers and peripheral devices, such as printers. Each computer on a LAN is equipped with a network 
adapter board and is connected to the network by a cable. A LAN allows users to share applications, 
data, and peripherals across the network.  

• Modem is a communications device that transmits signals over analog or digital telephone lines.  
• Network Basic Input/Output System (NetBIOS) is a network communications protocol that allows 

computer applications and devices to communicate over a LAN.  



• H.320 is an international standard published by the International Telecommunications Union (ITU) that 
defines how video, audio, and other data should operate over a switched digital network.  

• T.120 is a collection of data-oriented conferencing specifications published by the ITU. These 
specifications, which have been under development for several years, enable vendors to create 
compatible products for multi-player gaming, multi-user applications, and multipoint data conferencing. 
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